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Chapter 1. About Butterflyzer
Butterflyzer is an integrated desktop application for exploring, collecting, cataloging and visualizing social
media and related events. It shares features with Browsers, media clients, and content management tools, but
offers much more. It provides powerful analysis and curating capabilities like expensive web-based service
providers, but we don't pretend to give you all the answers...we don't even tell you what questions to ask.

Butterflyzer is like an in-house geek, research assistant, and librarian for the web. It can help you find and
quickly integrate information you need from various sources -- including Twitter, Open Calais, Topsy, Google
Insights, PlaceMaker and other web sources -- allowing you to focus on specific issues and events important
to you. Butterflyzer works on all the major platforms and uses open and standards based toolsets and data
storage solutions. It's easy enough to be used by everyone, but built on an architecture powerful and scalable
enough to serve demanding enterprise level tasks.
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Chapter 2. Installation
Installing Butterflyzer

Download and Open Butterflyzer
To install Butterflyzer, follow these simple steps:

• If you're using Windows, you'll need to first install the Java JRE. See the Oracle Java web site for details.

• Download the latest version from the Butterflyzer web site. Pick the version appropriate for your system.

• Unzip the Butterflyzer download. (Your web browser will often do this for you automatically. The file will
be named something Butterflyzer_(System), where System is your operating system and processor.)

• Move the directory to a convenient folder such as "Applications". Important: Do not remove the
"Butterflyzer" application from the "Butterflyzer_(System)" folder. The Butterflyzer application accesses
other files within the directory.

• Double-click on the Butterflyzer application.

• Please take the time to read the important Installation Notes section below.

Authorization and Security
When you launch Butterflyzer for the first time, you will be presented with a number of screens:

• Verify that you want to run the application. (This dialog varies by operating system.)

/wiki/http://www.java.com/en/download/index.jsp
http://butterflyzer.com/index.php/download
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• Authorize Butterflyzer to use your Twitter account. Why do we require this?

• Follow Butterflyzer by clicking on the "Follow" button. (This is not the default option.) Why do we require
this?

• Read the License Agreement and click "Agree" if you agree to its terms.

Twitter Authorization
In order for you to use Butterflyzer we require that you authorize the Butterflyzer application to access the
Twitter API, and that you follow us on Twitter. Why do we ask this?

1. We use the Twitter API to search for Tweets, Twitter Authors and other information. Twitter requires that
users be authorized in order to use the API. We manage this access for you. Note that we never take actions
on Twitter for you without your explicit authorization. Butterflyzer API access is "read-only" except for
the following rare cases:

a. When you agree to follow us.

/wiki/Twitter_Authorization
/wiki/Twitter_Authorization
/wiki/Twitter_Authorization
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b. In the future, we might suggest that you send a message to your followers about Butterflyzer. This
would be purely optional.

2. We use Twitter Followers to measure and track current usage. (We do not track specific usage, for example
when you open Butterflyzer, only that you are following us.)

3. It allows us to solicit feedback and connect with our customers. We respect and appreciate your following
us, and we try to make our @Butterflyzer. (We never send Tweets advertising other company's products
or services, and try to keep our own Tweets limited, informative, and hopefully interesting.)

4. Twitter follows are a part of our "viral" marketing strategy. When you follow us, other people are able to
see how many people are using Butterflyzer!

If these requirements are an issue for you, you can:

1. Use a different Twitter account for authorization and to follow us. (We ask that you not do that unless
necessary.) Or:

2. Unfollow us and Deauthorize the Butterflyzer application from within your Twitter account. It is not
necessary to launch Butterflyzer to do that. If you choose not to authorize and follow Butterflyzer you
must also discontinue using Butterflyzer and remove all copies of it from your system.

We welcome your feedback. Send us a note at contact@butterflyzer.com.

Installation Notes
1. This is commercial software. By using this software, you agree to the END USER LICENSE

AGREEMENT (EULA) shown when you first launch Butterflyzer. The EULA is available here:
http://butterflyzer.com/EULA.html. If at any point you no longer agree to the terms of the EULA,
you must discontinue use of Butterflyzer and remove all copies of Butterflyzer from your system.
Among other things, the software is time-limited and there is no promise of future availability. (If
you really want it, you know what to do.)   We disclaim all liability and there is no warranty.

2. This is early release software. Expect bugs. Files you create with this version may not work in future
versions.

3. System Requirement: Java 1.6. 4GB+ RAM Recommended.

4. Butterflyzer requires access to a Twitter account and that you follow us. In addition to needed functionality,
this helps us solicit feedback. (You can use a separate Twitter account if you'd rather not use your primary
account.) Naturally, we might use your public tweets for marketing purposes.

5. We don't yet have a full privacy policy, but the bottom-line is that we will not collect or share any
information that you do not explicitly provide to us. (Note that the Butterflyzer browser opens to the
Butterflyzer site at startup, and of course we do collect the same information for any Butterflyzer site visits
that we would for any other browser.)

6. We use a number of other web APIs from various providers. See the APIs section below. Some of these
have rate-limits and other rules, and usage of the Butterflyzer could bump you up against those rate
limits, in rare cases temporarily limiting your API access. We try to help you stay on the right side of
the line, but as with generic web browsers, Butterflyzer lets you do many things that we can't or don't
want to prevent you from doing. One of the big tasks in creating this software is the work required to
decode and adhere to the various API Terms of Service. We are making a good faith effort to meet ToS
requirements, but more importantly, we want to build strong relationships with service providers and users.
If you have specific concerns about compliance or want to build a partnership, please send an email to
contact@butterflyzer.com.

7. You should be especially mindful of user network searches. These will use up your Twitter search quota
very rapidly. Generally you should try to use mentions searches whenever possible as these make use of
already collected tweets.

8. This application is designed to work on all major platforms, but it has been tested most extensively on
Mac OS X. Your mileage on other platforms may vary.

http://butterflyzer.com/EULA.html
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9. We build the software, but your contribution is just as important. As a Beta user, please let us know what
works and what doesn't. Report bugs and give us feedback. You can post a note to the forums, or just
Tweet us at @butterflyzer.

10.One last thing. Your support of this effort really matters. If you like what you see, help make it happen
by spreading the word.

Service Providers
Butterflyzer helps you access the following services. Click on the link to access the respective Terms of
Service. The use of a company logo or name below does not imply an endorsement of Butterflyzer.

Google Web Search

Google News Search

Google Insights

Yahoo! Placemaker

/wiki/http://code.google.com/apis/websearch/terms.html
/wiki/http://code.google.com/apis/websearch/terms.html
/wiki/http://www.google.com/intl/en-US/insights/terms.html
/wiki/http://info.yahoo.com/legal/us/yahoo/api/api-2140.html
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Chapter 3. Help
Butterflyzer's help system is designed to get you the information that you need to understand the task that
you're doing now. You can bring up the help window by clicking on

Help button in the toolbar or selecting "Butterflyzer Help" from the Help Menu. To dismiss the help dialog,
click the close button ("X") next to the "Butterlyzer Help".

Active Help To find out about a specific topic, just hover (hold the mouse still for a second) over an
interface item. Or click on an item in a view to find out information about the item type.
From there you can explore related areas using hyper-links. Click the "Search" button to
find all information on a particular topic. Click contents to get a documentation overview.

Guide Get a complete tour of Butterflyzer functionality. Find out how to perform common
tasks -- such as Browsing, Searching, Managing Collections, Visualizing the Web,
Creating Web Exhibits, and more.

Reference Get detailed information about specific Butterflyzer features, including a
Glossary, User Interface, Toolbar and Actions.

Examples Play with some example butterflyzer catalogs.
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Chapter 4. Support
Having problems with a Butterflyzer feature? Can't figure out how to accomplish what you need to do? Want
to report a bug? Interested in building custom solutions based on Butterflyzer technology? Here are some
options:

Forum
For all questions, bug reports and feature requests, please visit the support forum.

To share ideas about using Butterflyzer and discuss related technologies, post a message to the discussion
forum.

Contact
If you can't resolve your question on the Butterflyzer forum, or have an issue or opportunity that you want to
talk with us directly about, please contact us using this secure online form.

Twitter
Twitter is an awesome way to communicate with us about @Butterflyzer. We love to hear about your
experiences using Butterflyzer, and we really love it when you share your interest in Butterflyzer with your
friends!

http://butterflyzer.com/index.php/forum/support
http://butterflyzer.com/index.php/forum/discussion
http://butterflyzer.com/index.php/forum/discussion
http://butterflyzer.com/index.php/forum
http://butterflyzer.com/index.php/support/contact
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Chapter 5. Guide
Take a complete tour of Butterflyzer features. You can move through these topics as a tutorial, or just dive
right into whatever interests you.

Working With Butterflyzer Get Active Help. Work with Views and Catalogs. Configure
Butterflyzer to do what you want.

Browsing and Searching Browse the Web as you never have before. Use powerful search
tools to find information. Quickly scan multiple web pages. Use the
Semantic Browser and Reader.

Taming your Web Pages and
Tweets

Organize your results using Collections and Tags.

Visualizing the Web Use graphs to quickly find the information you need. Get rid of the
clutter you don't. Discover information you didn't know existed.

Working With Butterflyzer
It's worth taking a few minutes to get familiar with how Butterflyzer does things.

Creating and Sharing Catalogs Butterflyzer stores everything in Catalogs. Find out how to work with
them.

Hiding and Showing Views Each Catalog contains Views. Focus on the views that are important
to you.

Creating and Sharing Catalogs
• Butterflyzer stores your search and navigation results in Catalogs. Find out more about Catalogs.

• When Butterflyzer opens for the first time, a catalog is created for you called "Main".

Create a new Catalog
To create a new catalog:

1. Select the File Menu and create a New Catalog.

2. If you want to give the Catalog a different name, Save it using a different name.

Save a Catalog
• Catalogs are automatically saved when you exit Butterflyzer.

• You can save a Catalog manually by selecting File → Save at anytime.

To name a file, or move it somewhere else, choose File Save As...

1. Enter a name for the Catalog.

2. Select a file-type. You have two choices:

• bflybin This stores the Butterflyzer file as a 'binary' file. This is a lower-level data format that stores
the information in a much more efficient way, but that can't be used outside of Butterflyzer. The binary
format makes files much smaller, and Butterflyzer can load the files much more quickly, so you should
use this format in most cases, but especially with large Catalogs.

• bflyxml This stores the Butterflyzer file as a text document. Since it uses a common data format
(XML) and is in plain text, you can open it with text editors, work with it using XML tools. The file
is also easier to recover if something goes wrong.

3. Save the file or cancel to keep the original name.
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Close a Catalog
When you close a Catalog, unlike the case with a Browser Tab, the Catalog itself doesn't go away. It's saved
in a file that you can reopen at anytime later. If you have a lot of Catalogs open, you may want to close some
in order to conserve system resources.

1. Select File → Close to close the current active Catalog.

2. Select File → Close All to close all open files within Butterflyzer.

Open an Existing Catalog
Whenever you reopen Butterflyzer, all of the Catalogs you had open when you last quit are reopened for
you. To re-open a Catalog that you previously closed or open a Catalog that someone has sent you, follow
these steps.

Please Note: You can't open a Butterflyzer Catalog by double-clicking from a file folder or an email as you
would with many other types of documents. Future versions of Butterflyzer will support this.

1. If the Butterflyzer application isn't already running, open it.

2. Select File → Open.

3. Navigate to the location of your Catalog and open the file.

Share a Catalog
Butterflyzer Catalogs are just files, so unlike browser Tabs you can easily share them with others. This makes
Butterflyzer files useful even when you're not using the more advanced features. And Butterflyzer Catalogs
store more than the Web Pages you've visited. They also store configuration information so that other people
will see an open Catalog in the same way you do.

Send a Catalog
1. Save the Catalog somewhere that you can easily find it, for example on your desktop or in your documents

folder. The file will have the extension .butter or .butterbin, depending on file format.

2. Create a new email in your Email Application.

3. Attach the butter file to your Email. See your email application documentation to find out how to attach
files to an Email.

4. Send the Email. (If the person receiving the Email doesn't have Butterflyzer, let them know they can get
the latest version at http://butterflyzer.com!)

Receive a Catalog
1. Save the file somewhere you can find it, such as your desktop or documents folder.

2. Open the Catalog.

Hiding and Showing Views
When you first open Butterflyzer, there are a lot of different views open. Get rid of the clutter to focus on
the task at hand.

For example, if you just want to browse the web:

1. Click on a Catalog to make sure that it is selected. (If the Background is white, it isn't selected.)

2. Open the View Menu and Uncheck "Show Outline" if it is checked.

3. Uncheck "Show Graph" if it is checked.

4. Uncheck "Show Table" if it is checked.

5. Check "Show Browser" if it is unchecked.

/wiki/Configuration
http://butterflyzer.com!
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You can also quickly hide and show views using the toolbar.

Find out more about the Outline, Graph View, Table View and Browser.

Browsing and Searching
Navigating and Collecting Web
Pages

Browse the Web. Collect Web Pages Links and Page Rankings.

Searching the Web Execute powerful searches against multiple Search Engines with one
key stroke.

Managing Searches Butterflyzer stores all of your searches. Find out how to work with
them.

Creating Complex Searches Combine searches and organize results in powerful ways using simple
tools.

Browsing Multiple Pages Use Browser Lists and Slider Panes to view multiple pages at once.

Enhanced Browsing See live tags within your web pages. Zero in on areas of interest. Use
the reader to quickly scan pages.

Navigating and Collecting Web Pages
Butterflyzer's fully integrated browser uses the same web engine as the one you're using now (you can even
pick the engine you want to use). So everything renders quickly and looks as you'd expect. (You can also
import everything you find in Butterflyzer into your desktop browser bookmarks.)

Most of the Navigation works just as you'd expect.

To open a new web page:

1. (Optional) simplify your views so that you have just the browser open.

2. Enter a URL (Web Page location) into the Search Field (the white area in the toolbar). For example, type
arstechnica.com.

3. Press the ENTER or RETURN key.

4. The web page loads into the browser.

See Back Button, Forward Button and Reload Button for common functions.

See Search Field for more information about how you can use the search field.

To collect the contents of a web page, including Semantics and statistics, do this:

1. When you collect a web page, Butterflyzer uses any Search Engine Options you've set up to load the page.
Make sure that you have selected the appropriate engine(s). (Optional)

2. Click the Collect Page button.

To collect all of the page links from the page, including Semantics and Statistics, do this:

1. Again, check that you the Search Engine Options. (Optional)

2. Click the Collect Page Links button.

Look here for other actions you take with a Web Page.

Searching the Web
Just as with any modern browser, Butterflyzer supports easy search capabilities. But with a Butterflyzer search
you get much more.

To execute a search, do this:

1. Select appropriate Search Engine(s) to use. For example, if you're only interested in Tweets, you might
want to unselect the Web related options.(Optional)
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2. Select views that allow you to see many results at a time. The Graph View and Table View are best for
this. (Optional)

3. Enter text into the Search Field. For example, you could enter "Apple".

4. Press the ENTER or RETURN key.

As soon as you press enter, the following things will happen:

• Butterflyzer will begin executing the searches. The Search progress is quite sophisticated -- it executes
searches in multiple threads and multiple stages according to the Search options you have selected. If you've
selected the whole enchilda, Butterflyzer will perfrom the following actions:

1. In parallel (beginning at the same time and executing simultaneously):

• A Google Web Search for related Web Pages.

• A Google News Search for related News Web Pages.

• A Topsy Search for related Web Pages and Tweets.

• A Twitter Search for Tweets including the search term.

2. After each of the Web Page searches are complete, Butterflyzer then performs the following actions
on the discovered pages:

• Collects Topsy Trackbacks on all collected pages.

• Collects Topsy Statistics on all collected pages.

• Collects semantic results from Open Calais using many queries in parallel.

3. After each of these stages, Butterflyzer does some maintenance with the results.

• All of this data will be captured to your Catalog. You can always Update an Existing Search with new
results later.

• The views will update with the new results. As the searches progress over time, new results will be added to
the results in any views you have open. For example, let's say you have just started a search on "Big Data".
If are viewing a Graph, and you have selected the "IBM" Semantic Tag in the "Companies" Semantic Type
in the Outline, as new Web Pages are discovered, the graph will grow.

That's a lot happening from one key stroke! Typically, you'll see Web Pages and Tweets coming back almost
instantly, with the more complex Semantic Results Tweet results completing within a minute or two. To find
out how the searches are coming along -- and to cancel searches that you no longer need -- you can watch
the progress of the searches in the Progress View.

(Why don't all of those searches slow your machine to a crawl? Most of the time you spend waiting for a web
search is the time spent for the search to travel to the web server, the web server to process the results, and
the results to be sent back to you. Your internet bandwidth and computer processing speed have very little
to do with this. By managing many -- sometimes dozens -- of simultaneous searches at a time Butterflyzer is
able to improve you search efficiency by orders of magnitude. Imagine the time it would take to go through
each of those searches by hand.)

Managing Searches
Every time that you create a search in the Search Field, Butterflyzer automatically creates a Tag for that
search. In the Searching the Web we created a search for Big Data. You can always see the results of a prior
search by selecting it in the Outline.

Navigating Searches
To Navigate to the search Results for an existing Tag, do this:

1. In the Outline open "Collections". (You can do this by clicking on the triangle or + icons to the left of
the Collections Icon.)

2. Open "Queries".
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3. Click on a Tag that has already been collected.

4. The other views will now show the results for that Tag from any prior search.

Updating Searches
To update the results for an existing Tag, simply:

1. Move your mouse over the Tag you're interested in.

2. Next, drag your mouse over the

Tools icon. The tools available for that item appear.

3. Select the

Search icon.

Creating Complex Searches
You can create powerful searches using just the Search Field by taking advantage of the search options
provided by various vendors. For example, in Google you can exclude entries by using the '-' symbol. But
Butterflyzer allows you to create more complex searches, as well as combine results from existing searches
into new sets. But Butterflyzer provides a much friendlier and more manageable way to put together complex
searches.

See the Set description for more about how sets work.

To create a set:

1. In the Outline, open the Collections Item.

2. Press the CTRL key and mouse over "Queries".

3. In the menu that appears, move to the

Add Menu.

4. Click on the

"Tag" button.

5. Type a tag name, for example "IBM".

6. Repeat steps 2-4 for another tag name. For example, type "Apple".

7. Now from the Add Menu select

"Or Set".

8. Drag the "IBM" and "Apple" into the new or Set.

To Search on a set or any other terms:

1. Press the CTRL key and mouse over the Set.

2. From the

Tools menu, select

Search.

Browsing Multiple Pages
The Butterflyzer browser is more than an ordinary browser...it supports unique features like gliding panes to
make it easy to scan many pages at once and find exactly those items that are most relevant to you.
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Find out how views work together to support multiple page browsing.

Using the List Browser Mode
To select a number of items to Browse in the List View:

1. Use the Show View Menu to hide all of the views except for your Outline and Browser views. (optional).

2. Perform a Search on the term "Apple".

3. Open the "Collections" entry in the Outline is it is not already open.

4. Wait for the "Auto-Tags" entry to appear and then open it. (Butterflyzer will be updating this information
constantly as the search progresses.)

5. Navigate to the "Person" Semantic Type and click on a Person, such as "Steve Wozniak".

6. Now, all articles within the search for "Apple" that mention "Steve Wozniak"" will be in the Result Items.

7. To see the articles available, click on the List at the top of the browser.

Using the Tiles Browser Mode
1. Select the Tiles Browser Mode.

2. Watch all of the pages load at once!

3. Now, just mouse into any of the items to expand it.

4. If there are more items in the Result Items then can fit in one tile view, just mouse to the bottom-most tile
to reveal more. If you want to move back up, just mouse over the top-most tile.

To see a Catalog already setup like this, download the Node JS Example.

Enhanced Browsing
In addition to the regular browser mode, you have two other browser options.

If you want to browse pages normally, without using the Semantic Browser of reader, just:

1. Unselect the Semantic Browser Menu Item

2. Unselect the Reader Item

Semantic Browser
The Semantic Browser is on by default. It highlights semantic tags created with the OpenCalais Search Engine.

To use tools on Semantic Tags within the browser, do this:

1. Hover over the tag.

2. When the menu comes up, click on any of the Item Actions or Tag Actions.

3. For example, to Focus on a Semantic Tag, click the Focus action.

Reader
The Reader shows the web pages in a simplified mode.

Taming your Web Pages and Tweets
Collections organize the information in your Catalog.

Working with Collections Find out what is in a Collection and how they are created and managed.

Selecting Items Find the results you're looking for. Learn how the Outline view works
with the other views.

Working with Tags Use Tags to track Resource items of interest.

/wiki/Searching_the_Web
/wiki/Semantic_Browser_Menu_Item
/wiki/Reader_Item
/wiki/Semantic_Browser
/wiki/OpenCalais_Search_Engine
/wiki/Semantic_Tag
/wiki/Item_Actions
/wiki/Tag_Actions
/wiki/Focus_Items
/wiki/Focus
/wiki/Reader
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Working with Collections
Each Catalog contains multiple Collections. Open the Collections node in the Outline to see your collections.

Collections are made up of Terms. See the Terms documentation for all of the terms. Collections themselves
are also terms, so you can create collections that contain other collections.

Within the Collections, there are up to three Collections that are created automatically as the result of searches:

Queries Contains all Queries that have been created from typing Search Term Tags into the Search
Field.

Auto Tags Contains all of the Semantic Types and the Semantic Tags created by the OpenCalais
Search Engine.

Tweet Terms Contains terms used in Tweets. These are either automatically discovered following a
search, or collected by the user with the Collect Tweet Terms action.

Selecting Items
In Butterflyzer, what you see in the other views is controlled by what you select in the Outline.

Selecting a Single Item
To select an item:

1. Use the Show View Menu to hide all of the views except for your Outline and Table View views. (optional).

2. Perform a Search on the term "Apple".

3. Open the "Collections" entry in the Outline is it is not already open.

4. Wait for the "Auto-Tags" entry to appear and then open it. (Butterflyzer will be updating this information
constantly as the search progresses.)

5. Navigate to the "Person" Semantic Type and click on a Person, such as "Steve Wozniak".

6. Now, all articles within the search for "Apple" that mention "Steve Wozniak" will be in the results menu.

7. The graph updates with the terms associated with the term "Apple". All of the related terms fit together
into a search box.

Selecting Multiple Items
To select multiple items:

1. Perform the steps in Selecting a Single Item.

2. Next hold down the ALT (Windows/Linux) or COMMAND (Mac) key, and click on another Person, such
as "John Sculley".

3. Now, all articles within the search for "Apple" that mention either "Steve Wozniak" or "John Sculley"
will appear in the Results.

Using Logical Selections
You can control whether Butterflyzer displays items that match any or your Focus Items or all of them. Read
about the Selection Matching Mode to find out more about how logical selections work.

To show pages that match all Focus Items:

1. Perform the steps in Selecting a Single Item and Selecting Multiple Items.

2. Next, click on the Selection Matching Mode item in the Outline Toolbar and select And.

3. Now, only those articles that include both "Steve Wozniak" or "John Sculley" will appear.

To return to the default match any behavior:

/wiki/Searching_the_Web
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1. Click on the Or Menu Item.

2. Now the results will again include those articles that include both "Steve Wozniak" and "John Sculley".

Working with Tags
You use Tags for searches, but they can also be used to keep track of manually organized Resources. Think
of them as like "Folders" for different pages or tweets that interest you.

Create a New Tag
To create a new Tag:

1. Hover over a Collection. In the

Menu, select

"Term".

2. In the Dialog that follows, give the Term a name.

Move a Tag
To move items to a Tag:

1. Show the Table View if it is not already showing.

2. Create a Tag (see above). Perhaps you might want to call it something like "Product Reviews".

3. Click on an existing Tag in the Outline. For example, you could click on "Apple" from a previous search.

4. Select articles in the Table View and drag them to the newly created Term.

Visualizing the Web
One of the key features of Butterflyzer is that it allows you to Navigate through enormous amounts of
information to zero in on just what you need and get rid of those pieces you don't.

Exploring Web Pages with Graphs Use the power of graphs in your internet research.

Visualizing Complex Relationships Discover the deep relationships between Resource items.

Exploring Web Pages with Graphs
To help us to understand graph relationships, Butterflyzer provides powerful and easy to user graphing tools.
The best way to understand how they work is to explore.

Before getting started, you might want to:

• Find out what Graphs are and how they work.

• Read more about Selecting Items.

Displaying Items in Graph
To quickly see the items related to a given Semantic Tag:

1. If you've been working with Butterflyzer already, Create a new Catalog (optional).

2. Use the Show View Menu to hide all of the views except for the Outline and Graph View (optional).

3. Perform a Search on the term "Apple".

4. Open the "Collections" entry in the Outline is it is not already open.

5. Open the "Queries" entry. (Butterflyzer will be updating this information constantly as the search
progresses.)

/wiki/Searching_the_Web
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6. Navigate to the "Apple" Search Term and click on it.

7. The graph updates with the terms associated with the term "Apple". All of the related terms fit together
into a search box.

• When a number of items all share the same relationship, they are placed into a single group.

• The size of text within the groups are set by your Scale Topsy Scale Related Scale Count.

Displaying Multiple Items in Graph
To see more complex relationships between multiple entities, try this:

1. Select "John Sculley" and "Steve Wozniak". See Selecting Multiple Items.

2. The view updates to display the relationships between articles with those two names.

• The items that both arrows point to contain both Tags. The items on the bottom left only mention "Steve
Wozniak". There are no articles that mention "John Sculley" and don't also mention "Steve Wozniak".

• Note how you can quickly identify complex relationships between entities in this way.

Visualizing Complex Relationships
Now let's look at how we can use the graph tools to find out what's inside a web page without looking and
to discover connections between web pages.
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Displaying Related Items in Graph
To show complex relationships between a number of different semanticall realted Web Pages, let's look at
how people are related within stories about Apple:

1. Follow the steps in Displaying Items in Graph.

2. Now, click on the "People" Semantic Type.

3. The graph will update and display different items.

• That's a lot of information! In the next section, we'll clean that up a bit.

Filtering Information in Graphs
There are many ways that you can filter information to reduce the size and complexity of a graph. See the
Filter Menu section for more ideas.

To reduce the clutter in your graph:

1. Follow the steps in Displaying Related Items in Graph.

2. In the Filter Menu select the Filter Categories Menu Item and the Filter Cliques Menu Item.

3. The graph will update with the filterred items removed.
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Removing Items from Results
When we've removed categories and cliques from the graph we often see "islands" of unrelated items.

To remove uninteresting items from a graph:

1. Follow the steps in Filtering Information in Graphs

2. Drag the mouse over one of the items and click the

Remove from Focus button.

3. Do the same thing for items in the other group.

4. Each time the items will be removed form the graph, and the view will be updated.

The graph should now look like this. Naturally, Steve Jobs is in the center.
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Simplifying the Graph Display
There are many things you can do to simplify the graph. Let's get rid of the text for the tags so we can focus
on the items themselves.

To find out about other options for reducing visual clutter see the Draw Options Menu section.

To hide item text:

1. Follow the steps in Removing Items from Results.

2. Unselect the Show Tag Text Menu Item in the Draw Options Menu.

3. The graph will update and display the tags as filled circles.
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Use Scale to Make Graphs Effective
There are many ways to customize the display to show just the information that you need in a compelling way.

To make the graph show number of articles by size:

1. If you haven't already done so, do a search for "Apple" in a new Graph. See Displaying Items in Graph.

2. Click the "OperatingSystem" category.

3. Select the Scale Count Menu Item and unselect the Scale Topsy and Scale Related items in the Draw
Options Menu.

Or you can just download the example file.
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For other visualization options, see the Draw Options Menu section.

Collecting and Sharing Data
Butterflyzer has powerful capabilities for integrating data from various sources. Read about how to use them
here.

Topsy Statistics
When you have the Topsy Search Engine enabled, Topsy metrics are obtained for Resources.

Topsy Web Page Statistics
Topsy gives information about how many Tweets there have been about a Web Page, and how many of
those Tweets were "influential" -- that is, that came form a Twitter Author that Topsy considers influential
according to the Topsy proprietary algorithms.

You can see this information in the Table View. The "All" column gives the total number of Tweets, and the
"Inf" column gives the number of influential Tweets.

If you have the Scale Topsy Menu Item selected, the number of Tweets about a given web page will be used
to determine how large to make the text or bubble for a given item in the Graph View. See Graph Settings
for more details.
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Statistics are also used to generate time plots and time lines. See the following sections for more on that.

Topsy Author and Tweet Statistics
Topsy also defines a proprietary metric for "user influence". See Topsy Influence Rankings for more on how
that number is calculated.

You can see user influence by viewing Authors in the Table View. The "Influence" column shows the Topsy
influence for authors who have had this data collected. (This value is often '0' as it is unusual for authors to
have any influence at all.)

If you have the Scale Topsy Menu Item selected, the influence of a given Author will be used to determine
how large to make the text or bubble for that author -- and that author's Tweets -- in the Graph View. See
Graph Settings for more details.

Google Insights
If you're used to manually collecting Google Insights data you'll be happy to find out that Butterflyzer handles
this for you. See Interest Query to find out more.

See Google Insights Terms of Service for important information about your usage of this data.

Collect Google Insights
To collect Google Insights data:

1. Create a New Tag. For example, you might create a tag called "Apple". (You can use existing tags too,
of course.)

2. Hold down the CTRL key, move over the tag, go to the tool menu and select Collect Google Statistics.
Butterflyzer opens a web page window and automatically navigates to the Google site for you. That
information is collected and added to the catalog.

View Google Insights
To view Google Insights data:

1. Collect Google Insights

2. Open the Tag you've ollected data for.

3. Select the Show Table Menu Item.

4. Select the Tags Resource Type Menu Item.

5. Click on one of the "Google" search items.

A list of values will appear for the data collected.

Create a Timeplot
Now, let's put all of that information together. You can create a custom Timeplot containing specific Web
Pages, Google Insights, relevant Tweets, and Topsy statistics, and then easily deploy it to any web server --
all without any Butterflyzer runtime dependencies.

To create a Timeplot:

1. Please note: Currently, Timeplot only supports XML data types. Before taking the following steps,
first save the file as .bfkyxml. An update will fix this limitation.

2. Hold down the CTRL key and move the mouse over the Tag you want to create a report for. From the
Tools menu, select Create Timeplot.

Butterflyzer creates a report, saves it, and opens it in a special web page view. (Not the Browser, where web
pages are usually displayed.)

The Timeplot html files can be found in a directory with the same name as the Catalog. To make your Timeplot
accessible from the Web, simply copy that directory to your web-site. (You can use ftp or any other web

http://topsylabs.com/social-signal/influence-on-the-social-web/
/wiki/Authors_Resource_Type_Menu_Item
/wiki/Tweet
http://www.google.com/intl/en-US/insights/terms.html
/wiki/Collect_Google_Insights
/wiki/Show_Table_Menu_Item
/wiki/Tags_Resource_Type_Menu_Item


Guide

Beta 23

transfer tool to do this. See your system documentation, talk to your system administrator, or visit your web-
host service for information on how to upload files to your web server.)

Create a Timeline
A Timeline shows every Web Page that has an occurred date within a timeline panel. You can filter the entries
using facets, so that web users can select documents based on Semantic Tag and other criteria.

To create a Timeline:

1. Please note: Currently, Timeplot only supports XML data types. Before taking the following steps,
first save the file as .bfkyxml. An update will fix this limitation.

2. Hold down the CTRL key and move the mouse over the Tag you want to create a report for. From the
Tools menu, select Create Timeline.

Butterflyzer creates a report, saves it, and opens it in a special web page view. (Not the Browser, where web
pages are usually displayed.)



Beta 24

Chapter 6. Reference
In this section of the guide, you can find in depth information about the Butterflyzer features and how to
use them.

Glossary What's a Catalog? If a Web Page the same thing as a Resource? Find out what
all of the terms we use in Butterflyzer mean and how they relate to each other.

User Interface Want to know more about how the Outline and other Views work
together? How to work with Tables? Explore the Butterflyzer User
Interface, including the Browser, Graph View and more.

Toolbar Items Find out how to work with Butterflyzer more efficiently and
effectively. Discover capabilities that you didn't know existed.
Wondering what that Flower Icon is for? Or how you can make the
Graph less busy? We answer those questions here.

Actions What's Focus for? What happens when I collect a Web Page? What are all of
the things I can do with Tweets? Find out about the actions that you can take
on Butterflyzer items.

Glossary
This reference section provides a complete set of definitions for "almost everything" in Butterflyzer. It also
provides a good overview of the overall data structure for Butterflyzer catalogs. (For readers with a more
technical bent, this includes object types used within Butterflyzer. If you'd like more information about
technical details, please contact us.)

Item Index
Author    Author References    Authors    Catalog    Collection    Configuration    Event    Interest Query  
  Issue    Item    Location References    Locations    Reference Collection    Resource    Search Term    Selection
History Item    Semantic Collection    Semantic Tag    Semantic Type    Set    Tag    Term    Time Selection
History Item    Tweet    Tweet References    Tweets    Twitter Session    Twitter Sessions    Web Page  
  Web Pages    Web Site    Web Sites  

Graph
Graphs are quite simple, really. They are a way of organizing and visualizing data that makes it possible
to understand complex relationships between different things. As a simple example, a family tree is a kind
of graph. And you've probably seen visualizations of social networks. But all information on the web is
connected through graphs. Butterflyzer reveals those graph relationships so that you can work with them
directly. Here are some basic terms to be familiar with:

Node
A node in a graph is any object that is used to represent a particular piece of information. An example of a
node would be a particular person within a family tree. In Butterflyzer, all nodes are Items.

Relationship
A relationship is any connection that exists between any two nodes. (Technically, we often refer to them
as "edges".) An example of a Relationship within a family tree is "mother". In Butterflyzer there are many
different kinds of relationships. Here are just a few examples:

• Links from one Web Page to another.

• Tags that contain Nodes. So for example, for a search on the term "Apple", any Web Pages or Tweets that
result from that search are relationships.

• Follower and Following relationships between Tweet Users.
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• "Trackbacks" for Tweets that refer to specific Web Pages.

As you use the Butterflyzer graph tools, you'll become more familiar with the different kinds of relationships.

Configuration
The configuration contains all of settings that determine how your catalog is setup. Because all of this
information is stored in the

Values

Google Search Engine
When selected, includes Google Web Search in search results. Please see the Terms of Service link to ensure
that your usage meets those terms. Butterflyzer does not monitor your usage and you alone are responsible
for ensuring your compliance.

External Sites: Google Web Search API Terms of Service.

Google News Search Engine
When selected, includes Google News Search in search results. Please see the Terms of Service link for
important legal information. Butterflyzer does not monitor your usage and you alone are responsible for
compliance with the service provider's terms.

External Sites: Google Web Search API Terms of Service.

Topsy Search Engine
When selected, adds Topsy Search to web page results, finds related Tweets using Topsy, and adds Topsy
ranking and influence metrics to Web Page and Tweet results. Please see the Terms of Service link for
important legal information. Butterflyzer does not monitor your usage and you alone are responsible for
compliance with the service provider's terms.

External Sites: Topsy Terms of Service.

Twitter Search Engine
When selected, includes Tweets obtained from Twitter in search results. Note that this can result in a large
number of Tweets that you may or may not be interested in. When you are primarily interested in Web Pages,
consider deselecting this option to avoid additional performance costs and storage requirements and avoid
hitting Twitter API limit. Please see the Terms of Service link for important legal information. Butterflyzer
does not monitor your usage and you alone are responsible for compliance with the service provider's terms.

External Sites: Twitter API Terms of Service.

Twitter Retrospective Search Engine
When selected along with the Twitter Search Engine option, includes retrospective Tweets in the results.
This option performs a separate search for each of that last seven days and can result in a large number of
Tweets selected. Users who are only interested in current results or Web Pages should consider deselecting
this option. Please see the Terms of Service link for important legal information. Butterflyzer does not monitor
your usage and you alone are responsible for compliance with the service provider's terms.

External Sites: Twitter API Terms of Service.

OpenCalais Search Engine
When selected, enriches the results of any web searches with the powerful semantic tagging service provided
by OpenCalais. Because this option collects a large number of tags, deselect it when you're only interested
in web search results. Please see the Terms of Service link for important legal information. Butterflyzer does
not monitor your usage and you alone are responsible for compliance with the service provider's terms.

External Sites: OpenCalais API Terms of Service.

http://code.google.com/apis/websearch/terms.html
http://code.google.com/apis/websearch/terms.html
http://topsylabs.com/products/api/
https://dev.twitter.com/terms/api-terms
https://dev.twitter.com/terms/api-terms
http://www.opencalais.com/terms
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Filter Other Resources
Remove items that aren't of the selected Resource Type from the graph and other results. For example, if Item
Type is set to Web Pages, selecting this option will remove Tweets and Authors from the results.

See also: Resource Type Menu.

Filter Cliques
Remove any items that don't have at least two connections to other items from the graph. This option is very
useful for reducing clutter, especially when combined with the Filter Categories option.

Filter Non-Topsy Ranked
Remove those items that don't have any influence recorded by the Topsy API. In order to be included, Web
Pages must have at least one Tweet referring to them, and Tweets and Users must have an influence level
greater than 0.

Filter Categories
Remove any categories from the graph. Categories are collections, semantic types and other outline items
that organize items. Selecting this item typically causes items and tags to no longer be organized in a hub and
spoke style. This option is most useful for the Spring layout, and is quite powerful when combined with the
Filter Cliques option. It doesn't work as well for Radial and Tree layouts, as it often causes items to appear
on top of one another.

Filter Members
Filter Members

Filter Retweets
Remove any Retweets from the results. This option is useful for narrowing down the set of Tweets to only
those Tweets that carry unique information. On the other hand, if you want to gauge overall interest in a topic
you should deselect this option.

Selection Matching Mode
Combines the selected items according to a logical rule. An Or selection contains those members (web page,
tweet, etc..) related to any of the focused items. This is a logical "OR" search." An And selection contains
only those members related to every focused items. This is a logical "AND" search. A Not selection contains
no members. This is a logical "NOT" search. This might be useful if you want to make changes in the Outline
View without affecting the other views.

Or

Combines selected items so that matching items are displayed for those selected items or tags.

And

Combines selected items so that matching items are displayed only for those selected items that are related
to all selected items or tags.

Not

Combines selected items so that no matching items are displayed. In other words, this turns selection mode
off!

Filter Followers
Ignore Twitter User followers when searching for related users. Note that if a Twitter user would be included
for another reason -- for example, if a user was also following the related user -- that user will still be included
in the results.
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Filter Following
Ignore other Twitter Users following the User when searching for related users. Note that if a Twitter user
would be included for another reason -- for example, if the user was also being followed by a related user --
that user will still be included in the results.

Filter Mutual
Ignores Mutual (two-way) relationships for Twitter Users when searching for related users.

Filter Mentions
Ignore related mentioned users of other users from the results.

Filter Followers Above
Filter Followers Above

Filter Celebrities
Filter Celebrities

Sample
Limit the number of related items. This option is useful when you have a large number of results and want to
explore them while avoiding performance issues. After discovering the set of results that are most relevant,
you can then deselect this option to see all related results.

Depth
Specifies how deeply relations between objects are searched. When an object is focused (for example, selected
in the outline view) related items are shown in the table, graph and browser as appropriate. The depth defines
how those related items are selected. For example, if Mark Twain has a 'book' relationship to Tom Sawyer,
and Tom Sawyer has a 'friendship' relationship to Huckleberry Finn, then if Depth 1 were selected, only Tom
Sawyer would appear in the graph. If Depth 2 were selected, both Tom Sawyer and Huckleberry Finn would
appear. (One way to think about this is as degrees of separation in "Kevin Bacon Space". The idea is that you
are looking for the number of connections between "friends of friends" that you would have to go through
to contact the actor.)

Depth 1

Sets the relationship depth to 1. This option works well for quickly examining relationships between tags and
items and other simple results.

Depth 2

Sets the relationship depth to 2. This option is often a good compromise between richness of relationships,
useful results and good performance.

Depth 3

Sets the relationship depth to 3. This option can result in a large number of results and can result in reduced
performance.

Infinite Depth

Include all relationships in the results regardless of distance from the focused items or tags. This means that
any items connected to the focused items will appear in the selection. This option only makes sense to use
when relations are very sparse. It can return a very large number of results it can result in poor performance.

Layout
Defines how items are placed on the graph. Different layouts are appropriate for different situations. For
example, when looking at hierarchical relationships such as for a web site, a horizontal tree might be
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appropriate, and when looking at complex relationships between many different kinds of entities, a spring
layout might be appropriate.

Spring Layout

Graph members organize themselves so that they are closest to those other items with which they share the
most edges. The graph continues to update automatically so that over time the graph structure will become
more organized.

Vertical Tree Layout

Graph members are arranged in a vertical tree format. Note that this can cause some items to appear off the
screen.

Horizontal Tree Layout

Graph members are arranged in a horizontal tree format.

Radial Layout

Graph members are arranged in a radial tree centered around a central set of nodes.

Resource Type
The primary resource of interest. The selected type defines what kinds of resources are shown in the table
view and can be used to filter out other types. When combined with the Filter Resource, graphs will show
just the selected resource type.

Web Pages Resource Type

Selects Web Pages as the primary interest type.

Tweets Resource Type

Selects Tweets as the primary interest type.

Authors Resource Type

Selects Authors (Users) as the primary interest type.

See also: Filter Other Resources.

Show URL
Display URLs in browser and caption views.

Show Icon
Display Icons for nodes in the Graph View.

Show Clip Info
Display information about where and when the item was collected in browser and caption views.

Show Items
When selected (default), items are shown in the Graph View. Hide Items by deselecting this option. This
allows you to focus on the relationships between terms and concepts embedded within Web Pages and Tweets.
Hiding items and connections (lines) greatly reduces screen clutter, but the underlying layout is still at work
organizing the information. This unique visualization combines the clarity of a cloud layout approach while
gathering related concepts together. Hiding items is most effective when combined with the Spring Layout.

See also: Spring Layout.
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Show Tags
When selected (default), tags are shown in the Graph View. Hide Tags by deselecting this option. This shows
related tags clustered together, allowing you to focus on the relationships between Tags without showing
the related resources. Hiding items and connections (lines) greatly reduces screen clutter, but the underlying
layout is still at work organizing the information. This unique visualization combines the clarity of a cloud
layout approach while gathering related concepts together. Hiding items is most effective when combined
with the Spring Layout.

See also: Spring Layout.

Show Item Text
When selected (default) text for Resource Items are displayed in the graph. For example, a Web Page node
will display the title of the web page, and a Tweet node will display the text of the Tweet. When unselected,
the nodes will be displayed as filled circles with their size defined by the scale settings.

See also: Scale Related.

Show Tag Text
When selected (default) text for Tags are displayed in the graph. For example, the tags for "Apple" and "IBM"
will be shown. When unselected, the nodes will be displayed as normal text.

See also: Scale Related.

Scale Related
Scales items displayed in the graph according to the number of related items that are connected to them. The
scale can be adjusted in the graph settings dialog.

See also: Graph Settings.

Scale Topsy
Scales items displayed in the graph according to the Topsy ranking for those items. The scale can be adjusted
in the graph settings dialog.

See also: Graph Settings.

Scale Count
Scales items displayed in the graph based on the number of items in a node. (This option is only relevant
when items are grouped together. The scale can be adjusted in the graph settings dialog.

See also: Graph Settings.

Reader
Displays any web pages in a Reader mode. The reader attempts to simplify text and removes most images
resulting in faster loading times and easier scanning. It works well with the Tile Browser Mode. Note that
when using the Semantic Browser, web pages are actually processed and then stored locally. Occasionally
there might be issues with processing web pages using the Reader. In that case, just unselect this option while
browsing those pages.

See also: Tiles Browser Mode Menu Item.

Semantic Browser
Displays web pages with Semantic Tagging. (Default.) Semantic Tags show up as colored text on a black
background. You can perform any available action on Tags within the Semantic Browser. Just hover over a
tag and the Context Menu will be displayed.

See also: Item Actions and Tag Actions.
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Show Table
Shows the Table View. See the Table View documentation for more details.

See also: Table View.

Show Browser
Shows the Browser. See the Browser documentation for more details.

Show Graph
Shows the Graph. See the Graph View documentation for more details.

See also: Graph View.

Show Outline
Shows the Graph. See the Outline documentation for more details.

See also: Outline.

Browser Mode
Defines how multiple browser items are displayed together. Choices include showing a single item with a list
selector and displaying two kinds of sliding tile layouts.

List Browser Mode

Browser pages are selected from a list.

See also: Using the List Browser Mode.

Tiles Browser Mode

Browser pages are sliding tiles.

See also: Using the Tiles Browser Mode.

Small Tiles Browser Mode

Browser pages are small sliding tiles.

See also: Using the Tiles Browser Mode.

Configuration items are connected to Catalog items.

Catalog
All of your collected content is stored within Catalogs. There is one Catalog for every Butterflyzer document.
Each Catalog appears in a single "Tab" within the Butterflyzer interface. See the

Catalog items are connected to Collection, Web Sites, Reference Collection, Locations, Selection History
Item, Configuration, Authors, Twitter Sessions, Tweets and Web Pages items.

Resource
A Resource is a single content item that is stored within a Catalog. Resources are the things that you're
interested in keeping track of, like Web Pages, Tweets, and content Authors. Generally resources can be
uniquely identified.

Web Site, Author, Tweet and Web Page items are also Resource items.

Item
An Item is simply any unit of information that is stored within a Butterflyzer Catalog, such as a Resource
or a Tag.
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Semantic Tag, Web Site, Search Term, Event, Tag, Set and Web Page items are also Item items. Item items
are connected to Selection History Item items.

Tweet
A Twitter message of 140 characters or less. In addition to the message itself and the related Author / Twitter
User data, Butterflyzer tracks other information about Twitter content, such as when it was collected, RT
type, and so on. There are a number of actions that you can take with Tweets -- see the Tweet Actions section
for more details.

See also: Tweet Actions. Tweet items are also Resource items. Tweet items are connected to Twitter Session,
Author and Web Page items.

Tweets
A collection of Tweets.

Tweets items are connected to Tweet items.

Tweet References
A collection of Tweets for a particular Session. Tweets removed from the session will still exist in the Catalog.

Tweet References items are connected to Tweet items.

Author
An Author is anyone who has created content. Currently all authors are assumed to be Tweet Users, as this is
a convenient way to track content authors across Web Sites and Tweets. In addition to basic information like
user name, Butterflyzer tracks other detailed information twitter provides such as Icon, Location and number
of Tweets. Using the Collect User Network actions, you can explore and track complex a User's complete
Social Network and then visualize the network using the Graph View. If the Topsy Search Engine is enabled,
the User data will include topsy Influence rankings. By the way, "Author" and "Twitter User" mean pretty
much the same thing, but future versions of Butterflyzer may support other content author types.

See also: Topsy Search Engine and Author Actions. External Sites: Topsy Influence Rankings. Author items
are also Resource items. Author items are connected to Event, Location References, Author References and
Tweet items.

Web Page
A Web Page is a Resource on the internet with a specific URL. In addition to the URL itself, Butterflyzer
tracks important details about the page, including when the page was collected, what Search Engine was used,
if any, and so on. Deep relationships between other Web Pages, Tweets and content authors are also tracked. If
you collect links for a page, those links are stored within the Catalog as well, enabling exploration of complex
relationships between content sources. If the Topsy engine is enabled, Butterflyzer will also collect Tweets
and Web Pages that mention the Web Page (Trackbacks). Topsy data is also used to track how many Tweets
there have been on a particular Web Page, and how many of those were from Influential users. Of course,
content for a page can change over time; currently Butterflyzer does not cache results, so a page might not
match perfectly with Tags that were created on earlier searches. See the Web Page Actions section for more
on what you can do with pages.

See also: Web Page Actions and Topsy Search Engine. Web Site items are also Web Page items. Web Page
items are also Resource and Event items. Web Page items are connected to Issue, Search Term, Author, Tweet
and Selection History Item items.

Authors
Contains all content authors (users) collected within the Catalog.

http://topsylabs.com/social-signal/influence-on-the-social-web/


Reference

Beta 32

Authors items are connected to Author items.

Author References
Contains Authors related to the parent item. An Author removed from References will not be removed from
the Catalog unless it is deleted.

Author References items are connected to Author items.

Issue
An Issue represents an area of concern. (Issues are not currently used within Catalogs but they will be
supported in future versions.)

Issue items are also Reference Collection items. Issue items are connected to Term items.

Term
A Term is anything that we might want to track within a Catalog.

Collection, Semantic Tag, Issue, Search Term, Reference Collection, Tag, Semantic Type, Semantic
Collection and Set items are also Term items.

Search Term
A Search Term is any Item that can be the subject of a generic search. Not all Search Terms are Tags; Search
Terms can also be made up of of a set of Tags such as in the case of Sets.

Semantic Tag, Tag and Set items are also Search Term items. Search Term items are also Item and Term
items. Search Term items are connected to Event, Tweet, Selection History Item and Interest Query items.

Semantic Collection
A collection of Semantic Types, which in turn contain Semantic Tags.

Semantic Collection items are also Term items. Semantic Collection items are connected to Semantic Type
items.

Semantic Tag
A Tag with well-defined Semantics. What this means is that the Tag is classified in a particular way, generally
by Semantic Type. For example the Semantic Tag "Apple" might have the Semantic Type "Company". Note
that different Semantic Tags may have the same value. For example, there might also exist a Semantic Tag
"Apple" with the Semantic Type "Food".

External Sites: OpenCalais Entity Disambiguation. Semantic Tag items are also Search Term items. Semantic
Tag items are connected to Event, Tweet, Selection History Item, Semantic Type and Interest Query items.

Semantic Type
A Semantic Type is a collection of Semantic Tags that have the same type -- that is they share the same
characteristics. For example, the Semantic Type "Food" might contain Semantic Tags like "Apple", "Corn
Flakes", and "Steak Tartare".

Semantic Type items are also Term items. Semantic Type items are connected to Semantic Tag items.

Tag
Tags an items for the given keyword. Tags are typically user-created, but can also be collected by
automatically. For example, Butterflyzer automatically creates tags for Tweet keywords.

Tag items are also Search Term items. Tag items are connected to Event, Tweet, Selection History Item and
Interest Query items.

http://www.opencalais.com/documentation/calais-web-service-api/api-metadata/entity-disambiguation
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Set
Combines any number of collections according to a logical rule. Drag another collection into this collection
to add it to the collections considered. An Or Set contains those members (web page, tweet, etc..) related to
any of the focused items. This is a logical "OR" search."An And Set contains only those members related to
every focused items. This is a logical "AND" search.

A Not Set excludes those members related to any focused items. This is a logical "NOT" search.

For example, if we created an "Or" Set that contained a collection of Flightless Birds and a collection of
Sea Birds, that collection would include Ostriches, Gulls and Penguins. If we placed those same collections
within an "And" Set, it would contain Penguins, but not Ostriches or Gulls. If we created a "Not" search
containing the Flightless Birds, and included that in an "Or" Set containing Sear Birds, the collection would
include Gulls, but not Ostriches or Penguins. Sets may be combined to create quite complex searches. For
example, you might create an "And" Set that contains Flightless Birds and that also contains another "Or" set
containing Sea Birds and Land Birds. The results would then include Ostriches and Penguins.

Set items are also Search Term items. Set items are connected to Event, Tweet, Selection History Item, Term
and Interest Query items.

Collection
Collections are used to organize Terms within a Catalog. A collection can contain Terms and other collections.

Collection items are connected to Term items.

Reference Collection
Collections are used for organizing a Catalog. A Reference Collection is made up of Terms and other
collections that are also members of a non-reference collection. When items are removed (but not deleted)
from a Reference Collection, they are not removed from the Catalog as a whole.

Issue items are also Reference Collection items. Reference Collection items are connected to Term items.

Interest Query
Interest Queries collect and store measurements of web user interest from Google Insights on Terms. To
modify what is collected, open the Properties Editor. Note that you must be signed into a Google service from
within Butterflyzer in order to collect Google Insights data. Please see the Terms of Service link for important
legal information. Butterflyzer does not monitor your usage and you alone are responsible for compliance
with the service provider's terms.

External Sites: Google Insights Terms of Service. Interest Query items are connected to Issue and Search
Term items.

Locations
Contains geographical locations.

Location References
Contains geographical locations for the parent item.

Web Site
Web Sites are the primary locations (top-level domains) for Web Pages. For example, if you were looking at a
NY Times article Web Page at http://nytimes.com/2010/11/01/ManBitesDog.html, the Web Site would be NY
Times at http://nytimes.com. Web Sites are automatically gathered for any sites when a search is performed.

Web Site items are also Web Page items. Web Site items are connected to Issue, Search Term, Author, Tweet
and Selection History Item items.

http://www.google.com/intl/en-US/insights/terms.html
http://nytimes.com/2010/11/01/ManBitesDog.html
http://nytimes.com
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Twitter Sessions
Butterflyzer stores Twitter searches in the contained sessions so that you can track collection activities.
Twitter Sessions are also used for streaming. Sessions are created automatically when you perform another
kind of search, and you can also create them manually with Add:Twitter Session. See the Twitter Streaming
documentation for more details on how to start streaming.

See also: Begin Streaming. External Sites: Twitter API Terms of Service. Twitter Sessions items are
connected to Twitter Session items.

Twitter Session
Twitter searches are stored as sessions. Sessions are also used to define and execute Twitter Streams. If you've
created a session manually, you'll need to define the terms for it. See the Twitter Streaming documentation
for more details on how to start streaming.

See also: Begin Streaming. External Sites: Twitter API Terms of Service. Twitter Session items are connected
to Reference Collection, Location References, Tweet References, Author References and Twitter Sessions
items.

Web Sites
Contains all Web Sites collected by Butterflyzer.

Web Sites items are connected to Web Site items.

Web Pages
A collection of Web Pages within the Catalog.

Web Pages items are connected to Event items.

Event
An Event represents a specific piece of information that is related to a specific time. For example, this might
be an actual event, a blog entry or a news story that appeared on a particular date.

Web Site and Web Page items are also Event items. Event items are connected to Issue, Search Term, Author,
Tweet and Selection History Item items.

Selection History Item
Selection History Items track user (in the sense of a Butterflyzer user, i.e. "you") interactions with Catalog
Items. These are used to track navigation history, but they can also appear in the Graph, allowing the
visualization of the Web Browsing process itself!

Time Selection History Item items are also Selection History Item items. Selection History Item items are
connected to Item items.

Time Selection History Item
A selection that also specifies a particular time period for the selection. These can be used to constrain
Tweets or Web Pages to just those that occurred within a particular date range. See the Select Time Span
documentation for more information.

Time Selection History Item items are also Selection History Item items. Time Selection History Item items
are connected to Item items.

User Interface
The Butterflyzer interface includes many features. Find out more about them here.

https://dev.twitter.com/terms/api-terms
https://dev.twitter.com/terms/api-terms
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How Views Work Together How does a selection in one view affect what you see in other views?
Find out here.

Context Menu How can you perform actions on individual items?

@Interface Components What are all of the parts of the Butterflyzer interface, and how do they
work together?

How Views Work Together
In order to understand how views work together, you just need to understand the concepts below. (If all of
this sounds a bit complicated, just spend a little time working with Butterflyzer and you'll quickly see how
it works!)

Focus Items
The focused items are the catalog items that you are interested in searching from. For example, if you are
looking for Web Pages related to the term "Butterflies", then then the Focused item will be "Butterflies". The
focused item(s) are always selected in the Outline, but you may not see them selected as their containing
items may not be open.

To focus on item(s), select them in the Outline or use the Focus action on items in any Results View. Whenever
you perform a search or type a new web page address into the Search Field, that search or new web page
will become the new focus.

Result Items
The result items are those items that you are interested in searching for. For example, if you are looking for
Web Pages related to the term "Butterflies", then then the Result Items will be the web pages themselves. All
result items may not always be displayed. For example, if you have the Filter Other Resources option selected,
and you have Resource Type set to Web Page, you will not see Tweets in the results. Results are displayed
in the Table View and Graph View. If there are no Selected Items then all of the results are displayed in the
Browser as well.

Selected Items
Selected items are those items that you have selected within the results views. Selected items are always
also Result Items. For example, within the web pages about Butterflies, you may have selected a number of
articles about Butterflies so that you can drag them into another Tag or view them in the Browser.

Selections are coordinated

Key Concept: If any items are selected in the Graph View or Table View those are the items that will be
displayed in the Browser

Primary Item
The primary item is the item that you are most interested in currently. A primary item will always be one of
the Selected Items. This is the item that will appear in the Search Field and the item displayed in the Browser
is you are using the List Browser Mode.

Context Menu
Context Menus allow you to take some action on an Item. To display the context menu for an item, just hold
down the CTRL key and drag the mouse over the item. (It isn't necessary to hold the CTRL key down when
working with the Graph View.) The context menu will appear. Just click the item you want to invoke.

See the Actions section for information about specific actions.

Interface Components
Results View A results view displays results from focused items.   read more...

/wiki/@Interface_Components
/wiki/Results_View
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Table View The Table View displays the current results for Resources of the
Selected Type in a spreadsheet format.   read more...

Graph View The Graph View displays the current results by visualizing Items as
"nodes" and Relationships between those nodes as ...   read more...

Outline The Outline is the primary way that you control what items are displayed
in other open views.   read more...

Browser The Browser is a fully functional Internet browser.   read more...

Toolbar The Toolbar provides all of the functionality you need for working with
a Butterflyzer Catalog.   read more...

Outline Toolbar The Outline Toolbar provides Outline specific tools.

Catalog Editor A Catalog Editor contains a single Catalog.   read more...

Table View
The Table View displays the current results for Resources of the Selected Type in a spreadsheet format. To
sort the table, click on the column header. When you move over an item, a context menu will appear at the
right side of the table allowing you to execute a number of actions on the item. Press the CTRL key and drag
the mouse over context menu items to display the action menu. When you select items in any result view, the
selection is updated in all of the other result views.

Graph View
The Graph View displays the current results by visualizing Items as "nodes" and Relationships between those
nodes as edges. There are many options you can use to modify the way that the graph looks. To select an
item, click on it. When you hover (pause) over an item, any hidden text will be revealed, and a context menu
will allow you to execute a number of actions on the item. Press the CTRL key and drag the mouse over
items to display the action menu. When you select items in any result view, the selection is updated in all
of the other result views.

Outline
The Outline is the primary way that you control what items are displayed in other open views. The current
selection in the outline defines the focus for the Catalog. For example, if you click on "Obama" in this view,
articles related to the President will appear in the Browser View, a list of those articles will appear in the Table
View, and the Graph View will show those same articles along with any related items. The results founds are
also affected by other option settings. For example, if Resource Type is set to Tweets and Filter Retweets is
selected, only those Tweets that include the selected terms and that are not Retweets will appear in the results.
The results are also controlled by the Selection Matching Mode. See the related items for more information.
Items are displayed in a tree structure. To open an item, just click the triangle (Macintosh) or + (Windows
and Linux) button next to the item. To select multiple items, hold down the Command (Macintosh) or Alt
(Windows and Linux) buttons while clicking. To close all items -- which you'll want to do when the lists get
too long -- click the Collapse Items button.

Browser
The Browser is a fully functional Internet browser. There are a number of different options for displaying the
browser. See the related items below for more information. The Browser uses the same underlying "engine"
as your other browsers, so everything should appear as you expect. To change the Browser engine, open
application Preferences (in the application menu on the Mac, or the Help menu otherwise), and navigate to
General:Web Browser.

Toolbar
The Toolbar provides all of the functionality you need for working with a Butterflyzer Catalog. See the
Toolbar documentation for details on all of the features.
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Outline Toolbar
The Outline Toolbar provides Outline specific tools. For details see the related items below.

Catalog Editor
A Catalog Editor contains a single Catalog. You use it very much like you would use a Tab in a typical
browser, but Butterflyzer is far from typical! See the Catalog section for more information on how
Catalogs work. See the Toolbar documentation for ideas about what to do with a Catalog. See the Outline
documentation to get started working with Catalog collections.

Outline Toolbar
The Outline Toolbar provides

Results View
A result view is a view that displays the selection for items that have been focused. For more information,
see Result Items.

Toolbar Items

The Butterflyzer toolbar gives you easy access to all Butterflyzer features. The next section provides details
on all of these tools.

Back Button    Browser Mode Menu    Collect Page Button    Collect Page Links Button    Depth Menu  
  Draw Options Menu    Filter Menu    Forward Button    Layout Menu    Reload Button    Resource Type
Menu    Search Engine Menu    Search Field    Show Help Button    Show View Menu    Tools Menu  

  Back Button
Go to previous item(s) in History

  Forward Button
Go to next item(s) in History

  Reload Button
Reload web pages or re-execute search.

  Collect Page Button
Collect Web Page.

  Collect Page Links Button
Collect Web Pages for all Web Page links (hrefs).   read more...

Search Field The Search Field functions just as you'd expect a Browser field to
work, but in Butterflyzer it does much more.   read more...

  Search Engine Menu
Select search services to use for search.

  Filter Menu
Remove items from results shown in views and used for other actions. 
  read more...

  Show View Menu
Select the view panels to display.

  Draw Options Menu
Options for drawing and displaying items in views and the browser. 
  read more...

The primary resource of interest.   read more...
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  Resource Type Menu

  Browser Mode Menu
Defines how multiple browser items are displayed together.   read
more...

  Layout Menu
Defines how items are placed on the graph.   read more...

  Depth Menu
Specifies how deeply relations between objects are searched.   read
more...

  Tools Menu
Perform actions on the selected objects, such as searching and
exporting.   read more...

  Show Help Button
Displays the Butterflyzer Help System

Back Button

 Go to previous item(s) in History

Forward Button

 Go to next item(s) in History

Reload Button

 Reload web pages or re-execute search.

Collect Page Button

 Collect Web Page. Semantics and statistics will be collected for the page if those Search Engines are enabled.

Collect Page Links Button

 Collect Web Pages for all Web Page links (hrefs). Semantics and statistics will also be collected if those
Search Engines are enabled.

Search Field
The Search Field functions just as you'd expect a Browser field to work, but in Butterflyzer it does much
more. Enter a URL to navigate to a page. (And naturally, you don't have to enter the "http://" part.) The page
will open into the Browser View (if shown) and will also appear in the Graph View and Table View. When
a URL appears here, you can perform actions on that URL, such as Collecting Links and Statistics. See the
Actions documentation for more information on what you can do with different Resources. Enter a phrase
to perform a Search on the phrase. Butterflyzer immediately goes to work collecting information from all of
the enabled Search Engines. Depending on the options you've selected, the catalog will fill with Web Pages
collected from Google, Tweets collected from Twitter, statistics on those pages along with Trackbacks from
Topsy and automatically collected Semantics from OpenCalais. And all of these sources are connected to
each other. Bet your Browser's search bar can't do that! See the Search Engine documentation for more on
the Search options.

See also: Browser Mode Menu, Searching the Web, Navigating and Collecting Web Pages and Search Engine
Menu.
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Search Engine Menu

 Select search services to use for search.

Google Search Engine Menu Item

 When selected, includes Google Web Search in search results. Please see the Terms of Service link to ensure
that your usage meets those terms. Butterflyzer does not monitor your usage and you alone are responsible
for ensuring your compliance.

External Sites: Google Web Search API Terms of Service.

Google News Search Engine Menu Item

 When selected, includes Google News Search in search results. Please see the Terms of Service link for
important legal information. Butterflyzer does not monitor your usage and you alone are responsible for
compliance with the service provider's terms.

External Sites: Google Web Search API Terms of Service.

Twitter Search Engine Menu Item

 When selected, includes Tweets obtained from Twitter in search results. Note that this can result in a large
number of Tweets that you may or may not be interested in. When you are primarily interested in Web Pages,
consider deselecting this option to avoid additional performance costs and storage requirements and avoid
hitting Twitter API limit. Please see the Terms of Service link for important legal information. Butterflyzer
does not monitor your usage and you alone are responsible for compliance with the service provider's terms.

External Sites: Twitter API Terms of Service.

Twitter Retrospective Search Engine Menu Item

 When selected along with the Twitter Search Engine option, includes retrospective Tweets in the results.
This option performs a separate search for each of that last seven days and can result in a large number of
Tweets selected. Users who are only interested in current results or Web Pages should consider deselecting
this option. Please see the Terms of Service link for important legal information. Butterflyzer does not monitor
your usage and you alone are responsible for compliance with the service provider's terms.

External Sites: Twitter API Terms of Service.

Topsy Search Engine Menu Item

 When selected, adds Topsy Search to web page results, finds related Tweets using Topsy, and adds Topsy
ranking and influence metrics to Web Page and Tweet results. Please see the Terms of Service link for
important legal information. Butterflyzer does not monitor your usage and you alone are responsible for
compliance with the service provider's terms.

External Sites: Topsy Terms of Service.

OpenCalais Search Engine Menu Item

 When selected, enriches the results of any web searches with the powerful semantic tagging service provided
by OpenCalais. Because this option collects a large number of tags, deselect it when you're only interested

http://code.google.com/apis/websearch/terms.html
http://code.google.com/apis/websearch/terms.html
https://dev.twitter.com/terms/api-terms
https://dev.twitter.com/terms/api-terms
http://topsylabs.com/products/api/
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in web search results. Please see the Terms of Service link for important legal information. Butterflyzer does
not monitor your usage and you alone are responsible for compliance with the service provider's terms.

External Sites: OpenCalais API Terms of Service.

Filter Menu

 Remove items from results shown in views and used for other actions. One of the challenges in working
with content is that we actually have far too many connections between content items. These filter options
are very useful for reducing the large number of related items that Butterflyzer can find for you. While the
options may seem a little overwhelming initially, it is worth taking some time to explore how they work.

Filter Categories Menu Item

 Remove any categories from the graph. Categories are collections, semantic types and other outline items
that organize items. Selecting this item typically causes items and tags to no longer be organized in a hub and
spoke style. This option is most useful for the Spring layout, and is quite powerful when combined with the
Filter Cliques option. It doesn't work as well for Radial and Tree layouts, as it often causes items to appear
on top of one another.

Filter Cliques Menu Item

 Remove any items that don't have at least two connections to other items from the graph. This option is very
useful for reducing clutter, especially when combined with the Filter Categories option.

Filter Other Resources Menu Item

 Remove items that aren't of the selected Resource Type from the graph and other results. For example, if
Item Type is set to Web Pages, selecting this option will remove Tweets and Authors from the results.

See also: Resource Type Menu.

Filter Non-Topsy Ranked Menu Item

 Remove those items that don't have any influence recorded by the Topsy API. In order to be included, Web
Pages must have at least one Tweet referring to them, and Tweets and Users must have an influence level
greater than 0.

Filter Retweets Menu Item

 Remove any Retweets from the results. This option is useful for narrowing down the set of Tweets to only
those Tweets that carry unique information. On the other hand, if you want to gauge overall interest in a topic
you should deselect this option.

Filter Followers Menu Item

 Ignore Twitter User followers when searching for related users. Note that if a Twitter user would be included
for another reason -- for example, if a user was also following the related user -- that user will still be included
in the results.

Filter Following Menu Item

http://www.opencalais.com/terms
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 Ignore other Twitter Users following the User when searching for related users. Note that if a Twitter user
would be included for another reason -- for example, if the user was also being followed by a related user --
that user will still be included in the results.

Filter Mutual Menu Item

 Ignores Mutual (two-way) relationships for Twitter Users when searching for related users.

Filter Mentions Menu Item

 Ignore related mentioned users of other users from the results.

Sample Menu Item

 Limit the number of related items. This option is useful when you have a large number of results and want to
explore them while avoiding performance issues. After discovering the set of results that are most relevant,
you can then deselect this option to see all related results.

Select Time Span

 Select time period for items and animate selection over time.

Show View Menu

 Select the view panels to display.

Show Outline Menu Item

 Shows the Graph. See the Outline documentation for more details.

See also: Outline.

Show Browser Menu Item

 Shows the Browser. See the Browser documentation for more details.

Show Graph Menu Item

 Shows the Graph. See the Graph View documentation for more details.

See also: Graph View.

Show Table Menu Item

 Shows the Table View. See the Table View documentation for more details.

See also: Table View.

Draw Options Menu
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 Options for drawing and displaying items in views and the browser. As with the Filter menu, these options
can be very helpful in managing information overload.

Semantic Browser Menu Item

 Displays web pages with Semantic Tagging. (Default.) Semantic Tags show up as colored text on a black
background. You can perform any available action on Tags within the Semantic Browser. Just hover over a
tag and the Context Menu will be displayed.

See also: Item Actions and Tag Actions.

Reader Menu Item

 Displays any web pages in a Reader mode. The reader attempts to simplify text and removes most images
resulting in faster loading times and easier scanning. It works well with the Tile Browser Mode. Note that
when using the Semantic Browser, web pages are actually processed and then stored locally. Occasionally
there might be issues with processing web pages using the Reader. In that case, just unselect this option while
browsing those pages.

See also: Tiles Browser Mode Menu Item.

Show Items Menu Item

 When selected (default), items are shown in the Graph View. Hide Items by deselecting this option. This
allows you to focus on the relationships between terms and concepts embedded within Web Pages and Tweets.
Hiding items and connections (lines) greatly reduces screen clutter, but the underlying layout is still at work
organizing the information. This unique visualization combines the clarity of a cloud layout approach while
gathering related concepts together. Hiding items is most effective when combined with the Spring Layout.

See also: Spring Layout.

Show Item Text Menu Item

 When selected (default) text for Resource Items are displayed in the graph. For example, a Web Page node
will display the title of the web page, and a Tweet node will display the text of the Tweet. When unselected,
the nodes will be displayed as filled circles with their size defined by the scale settings.

See also: Scale Related.

Show Tags Menu Item

 When selected (default), tags are shown in the Graph View. Hide Tags by deselecting this option. This shows
related tags clustered together, allowing you to focus on the relationships between Tags without showing
the related resources. Hiding items and connections (lines) greatly reduces screen clutter, but the underlying
layout is still at work organizing the information. This unique visualization combines the clarity of a cloud
layout approach while gathering related concepts together. Hiding items is most effective when combined
with the Spring Layout.

See also: Spring Layout.

Show Tag Text Menu Item

 When selected (default) text for Tags are displayed in the graph. For example, the tags for "Apple" and
"IBM" will be shown. When unselected, the nodes will be displayed as normal text.
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See also: Scale Related.

Show Icon Menu Item

 Display Icons for nodes in the Graph View.

Show URL Menu Item

 Display URLs in browser and caption views.

Show Clip Info Menu Item

 Display information about where and when the item was collected in browser and caption views.

Scale Count Menu Item

 Scales items displayed in the graph based on the number of items in a node. (This option is only relevant
when items are grouped together. The scale can be adjusted in the graph settings dialog.

See also: Graph Settings.

Scale Related Menu Item

 Scales items displayed in the graph according to the number of related items that are connected to them. The
scale can be adjusted in the graph settings dialog.

See also: Graph Settings.

Scale Topsy Menu Item

 Scales items displayed in the graph according to the Topsy ranking for those items. The scale can be adjusted
in the graph settings dialog.

See also: Graph Settings.

Graph Settings

 Opens a Tool window for making changes in graph settings. These settings determine how the graph draws
items in the graph. To make changes, drag the slider or enter a value in the field. Experiment with different
settings to become familiar with what they do. For example, if fonts are too large in the graph, you can adjust
the maximum size downward. The scaling items are work in the opposite way you might expect -- Setting
the values lower will tend to make items larger. That's because the values represent the maximum value for a
given scale. For example, if you expected almost all of your items to have no more than 50 items, you would
set Count Items Scaling to 50. In this case, groups of items of 50 would be displayed in the largest possible
size , and groups with 10 items would be displayed in a much smaller size. Topsy Bias reflects the relative
importance you put on "Influential" vs. other Authors. Topsy Influential Threshold sets the influence number
a user must have in order to be considered influential.

Spring Layout Settings

 Opens a Tool window for changing the way that the Spring Layout determines node locations. To make
changes, drag the slider or enter a value in the field. If items are grouped to closely together or don't cluster
well, you can often get better results by adjusting these values. Some values work better for different sorts of



Reference

Beta 44

graphs, so there isn't one best set setting for these values, though the default values are good for most general
graphs. The best way to understand what each of the settings does is simply to play with different values.

Resource Type Menu

 The primary resource of interest. The selected type defines what kinds of resources are shown in the table
view and can be used to filter out other types. When combined with the Filter Resource, graphs will show
just the selected resource type.

Web Pages Resource Type Menu Item

 Selects Web Pages as the primary interest type.

Tweets Resource Type Menu Item

 Selects Tweets as the primary interest type.

Authors Resource Type Menu Item

 Selects Authors (Users) as the primary interest type.

Tags Resource Type Menu Item

 Set ItemType to Tags.

Browser Mode Menu

 Defines how multiple browser items are displayed together. Choices include showing a single item with a
list selector and displaying two kinds of sliding tile layouts.

List Browser Mode Menu Item

 Browser pages are selected from a list.

See also: Using the List Browser Mode.

Tiles Browser Mode Menu Item

 Browser pages are sliding tiles.

See also: Using the Tiles Browser Mode.

Small Tiles Browser Mode Menu Item

 Browser pages are small sliding tiles.

See also: Using the Tiles Browser Mode.

Layout Menu

 Defines how items are placed on the graph. Different layouts are appropriate for different situations. For
example, when looking at hierarchical relationships such as for a web site, a horizontal tree might be



Reference

Beta 45

appropriate, and when looking at complex relationships between many different kinds of entities, a spring
layout might be appropriate.

Spring Layout Menu Item

 Graph members organize themselves so that they are closest to those other items with which they share the
most edges. The graph continues to update automatically so that over time the graph structure will become
more organized.

Vertical Tree Layout Menu Item

 Graph members are arranged in a vertical tree format. Note that this can cause some items to appear off
the screen.

Horizontal Tree Layout Menu Item

 Graph members are arranged in a horizontal tree format.

Radial Layout Menu Item

 Graph members are arranged in a radial tree centered around a central set of nodes.

Depth Menu

 Specifies how deeply relations between objects are searched. When an object is focused (for example,
selected in the outline view) related items are shown in the table, graph and browser as appropriate. The depth
defines how those related items are selected. For example, if Mark Twain has a 'book' relationship to Tom
Sawyer, and Tom Sawyer has a 'friendship' relationship to Huckleberry Finn, then if Depth 1 were selected,
only Tom Sawyer would appear in the graph. If Depth 2 were selected, both Tom Sawyer and Huckleberry
Finn would appear. (One way to think about this is as degrees of separation in "Kevin Bacon Space". The
idea is that you are looking for the number of connections between "friends of friends" that you would have
to go through to contact the actor.)

Depth 1 Menu Item

 Sets the relationship depth to 1. This option works well for quickly examining relationships between tags
and items and other simple results.

Depth 2 Menu Item

 Sets the relationship depth to 2. This option is often a good compromise between richness of relationships,
useful results and good performance.

Depth 3 Menu Item

 Sets the relationship depth to 3. This option can result in a large number of results and can result in reduced
performance.

Infinite Depth Menu Item
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 Include all relationships in the results regardless of distance from the focused items or tags. This means that
any items connected to the focused items will appear in the selection. This option only makes sense to use
when relations are very sparse. It can return a very large number of results it can result in poor performance.

Tools Menu

 Perform actions on the selected objects, such as searching and exporting. The items available vary for the
selected object(s).

Show Help Button

 Displays the Butterflyzer Help System

Actions

The following section details everything you can do with items in Butterflyzer listed by item type.

To see the action menu for an item, just hold down the CTRL-key and mouse over it.

Index
Author Actions    Collection Actions    Interest Query Actions    Tag Actions    Tweet Actions    Twitter
Session Actions    Web Page Actions  

Item Actions
The following actions can be performed on all items.

Focus

 Select this item(s) in the outline, causing it to be the new focus for all other views and the center of the graph.

Remove from Focus

 Remove from Focus

Delete

 Permanently remove item from entire catalog.

Prune

 Permanently remove this item -- and all objects directly connected to it -- from the catalog.

Caption

 Shows the Web Page in a caption, enabling quick scanning of resource content.

UnCaption

 Hides the Caption.
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Author Actions

Collect Topsy User Statistics
Collect User information including influence statistics from Topsy. Topsy is rate-limited, but generally you
can collect more information using the Topsy API than you can using the Twitter API.

Collect Quick Social Network
Collects and builds social networks for the selected users using the current settings defined in the Filter Menu.
Note that as this option collects user data it can cause you to go over your Twitter API quota.

Collect Custom Social Network...
Collects and builds social networks for the selected users. The search dialog allows you to specify what data
should be collected. Because social networks grow very large very quickly, it probably doesn't make sense
to search much beyond depth 1 unless you have special a higher level of Twitter API access. When you use
this search, note that you will probably bump up against Twitter limits. Butterflyzer handles this situation
gracefully, but it will mean that you might have reduced Twitter access for a short time after doing user
network searches.

Collect Details
Gathers User details from Twitter. When Butterflyzer collects Twitter Users from Tweets -- after a Search
for example -- the User data itself is not collected. This allows you to collect data such as screen name, user
icon, and user description. Note that as this option collects user data it can cause you to go over your Twitter
API quota.

Tweet Actions

Collect Tweet Users
Collects all Users from related Tweets. In a normal Tweet search, User information isn't collected from
Twitter. (That would be very slow and would very quickly use up your Twitter API quota!) Instead, we simply
create Author items representing the users including their unique ID.) To collect the user data itself, you can
use this option. You should be careful not to include too many users to avoid going over your Twitter API
limit.

Collect Tweet Terms
Searches through all related Tweets, identifies frequently used words, and creates terms containing them.

Twitter Session Actions

Collect Tweet Users
Collects all Users from related Tweets. In a normal Tweet search, User information isn't collected from
Twitter. (That would be very slow and would very quickly use up your Twitter API quota!) Instead, we simply
create Author items representing the users including their unique ID.) To collect the user data itself, you can
use this option. You should be careful not to include too many users to avoid going over your Twitter API
limit.

Collect Tweet Terms
Searches through all related Tweets, identifies frequently used words, and creates terms containing them.

Search Tweets
Searches for Tweets that contain the selected Search Term.
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Search Tweets and Users
Searches for Tweets that contain the selected Search Term, gathering Twitter Users in the process. Note that
as this option collects user data you can very rapidly go over your Twitter API quota.

Begin Streaming
Starts a Twitter streaming session. This collects Tweets from Twitter in real time, allowing the collection of
many thousands of Tweets quickly and efficiently, and enabling live monitoring of Twitter traffic. In general,
you should only have one Twitter Stream activate at any given time. To stop collecting from a Twitter Stream,
open the Progress view and click the stop button for the stream.

Tag Actions

Collect OpenCalais Tags
Collect semantic tags from OpenCalais from selected Web Pages.

Search
Search for Items with this Term using the selected Search Engines.

Collect Google Statistics
Collect Statistics using Google Insights.

Create Timeplot
Create a web-based Timeplot exhibit for related Web Pages and Tweets.

Create Timeline
Create a web-based Timeline exhibit for related Web Pages and Tweets.

Collect Tweet Terms
Searches through all related Tweets, identifies frequently used words, and creates terms containing them.

Collection Actions

Remove Lowest Terms...
Removes Terms within the selected collections (Tags) that are related to less than the specified number of
Tweets. This action is extremely useful for managing large collections of Tweets, as the number of collected
terms can grow very quickly.

Sort
Sort contained items and terms. Web Pages, Tweets, Authors and other Items are sorted alphabetically.
Semantic types are sorted into common sense categories.

Export Bookmarks
Export bookmarks in a standard format for use in other browsers.

Web Page Actions

Collect Page
Collect Web Page. Semantics and statistics will be collected for the page if those Search Engines are enabled.
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Collect Page Links
Collect Web Pages for all Web Page links (hrefs). Semantics and statistics will also be collected if those
Search Engines are enabled.

Collect Topsy Trackbacks
Collect trackbacks to Web Pages for Tweets and other Web Pages from Topsy.

Collect Topsy Statistics
Collect statistics and influence rankings from Topsy.

Interest Query Actions

Collect Google Statistics
Collect Statistics using Google Insights with selected statistics definition.
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Chapter 7. Appendix
Examples

We've created a few example catalogs, with many more coming soon.

Opening Example Catalogs
To open and example:

1. Click on one of the example model links to download the file to a location on your local machine. (You
may need to do this from your standard browser.)

2. Open the catalog. See this section for details.

Example Model Links

Apple Example
http://butterflyzer.com/docs/examples/Apple.bflybin

Shows a simplified graph visualization as described in Use Scale to Make Graphs Effective.

Node JS Example
http://butterflyzer.com/docs/examples/NodeJS.bflybin

Shows an example of Browsing Multiple Pages.

SOPA Example
http://butterflyzer.com/docs/examples/SOPA.bflybin

Shows a visualization example discussed in this blog entry.

http://butterflyzer.com/docs/examples/Apple.bflybin
http://butterflyzer.com/docs/examples/NodeJS.bflybin
http://butterflyzer.com/docs/examples/SOPA.bflybin
http://milesparker.blogspot.com/2011/12/forecast-spring-clouds-and-sopa.html
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